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본 소프트웨어는, 바이올린 몸체(Mould)의 곡선을 디자인하기 위한 프로그램입니다. 바이올린의 몰드 디자
인 방법은 여러가지가 존재하지만, 복잡하거나 부분 수정이 어려워서 실제 악기 제작에는 사용하기가 쉽지
않습니다. 그중 가장 큰 문제는, 곡선 상에 《불연속점》이 존재하며 곡선이 매끄럽지 않다는 점입니다.

이는 반지름(곡률)이 다른 두 개의 원호를 서로 이어붙이는 디자인 방법에 따른 결과로써, 곡률이 다른 두 개의 원호가
이어지는 지점에서는 눈으로 볼 때 미세한 꺾임(불연속점)이 느껴질 수 밖에 없고, 또한 실제 악기에는 완전한 원호가
아닌 점진적으로 곡률이 변하는 곡선이 사용되고 있기 때문입니다.

위의 문제점을 해결하기 위하여 본 프로그램에서는 원호 대신 《클로소이드(Clothoid) 곡선》을 사용합니다. 클로소이드
곡선은 곡률이 점진적으로 변화하는 곡선으로서 대단히 매끄러운 곡선을 제공합니다. 그러나 곡선의 휘는 방향이
동일할 때, 어떤 고정된 두 개의 점을 잇는 클로소이드 곡선은 단 하나의 모양만 가지고 있다는 특징을 가지고 있습니다.
즉, 모양을 바꿀 수 없습니다. 이는 다양한 모양을 가진 악기의 곡선을 표현할 수 없다는 뜻이기도 합니다. 이 문제를
해결하기 위하여 본 프로그램에서는 3개의 클로소이드 곡선이 하나로 연결된 곡선(본서에서는 《멀티클로소이드 곡선》
로 표기)을 사용합니다. 이러한 멀티클로소이드 곡선을 사용하면 곡선과 곡선이 이어지는 지점에 불연속점이 생
기지 않으므로 전체적으로 대단히 매끄러운 곡선을 작성할 수 있고 다양한 모양의 곡선을 자유롭게 생성할 수 있습니다.

Violin Designer, ver.3.0.0 에서는 일부 기능과 표기가 변경/추가되었으며, 사용설명서도 새로 작성하였습니다.
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1 ver.3.0.0의 변경 사항

• 메인 윈도우 UI 일부 변경, 용어 일부 변경
• 곡선의 곡률(CUR.)값 입력 단위 변경 (0.004 입력 > 4.0 입력, 입력시 큰 수로 입력하도록 변경)
• 결과 그래프 표시 방법과 항목 변경/추가
- [Overlap Graph/Redraw Graph/New Graph]의 라디오버튼으로 변경
- [Arch Profile] 참고선 추가

• 파일 저장 버튼 분리
• 파일 저장시 파일명에 저장 시각 추가 (NewDesign.pdf > New_Design_2026-02-21_20-12-20.pdf)
• 설정 파일 가져오기/내보내기 기능 추가
• 참고 이미지 기능 추가
• 그 외 에러 수정
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2 본 소프트웨어의 기능

2.1 디자인

• 멀티클로소이드 곡선을 이용한 자동 디자인
• 코너 폭의 자동 계산(Method H.I.S.)
• 결과 곡선의 표시 항목(레이어) 선택
• 결과 곡선의 갱신 방법 선택
• 참고용 악기 이미지 표시 기능
• 설정값의 가져오기와 내보내기
• 악기별 초기값 제공(프리셋)

2.2 출력

• 결과 곡선의 화면 출력
• 결과 곡선의 PDF 파일 출력
• 결과 곡선의 DXF 파일 출력
• 결과 곡선 수치값의 TXT 파일 출력

2.3 분석

• 디자인에 사용된 파라미터값 표시
• 각 부위별 수치값 표시
• 각 부위별 비례값 표시
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3 인스톨

본 소프트웨어는 포터블 버전이므로 별도의 설치 작업은 필요없습니다. 압축을 풀고 《Violin_Designer_v.X.X.X.exe》
파일을 더블 클릭하면 바로 프로그램이 실행됩니다. 단, 컴퓨터의 사양에 따라 실행에 시간이 오래 걸리는 경우가
있습니다.

인스톨과 프로그램 실행시에는 다음과 같은 점에 주의하여야 합니다.

■ 관리자 권한으로 실행

《Violin_Designer_v.X.X.X》 폴더가 C드라이브의 《Program Files》 등 윈도우의 시스템 폴더 안에 있는 경우에는 프로
그램 실행시 반드시 [관리자 권한으로 실행]하여야 합니다. 그렇지 않은 경우 제대로 동작하지 않거나, PDF, DXF,
TXT 파일 등이 정상적으로 저장되지 않을 수 있습니다.

■ 윈도우 보안 설정

프로그램 파일의 압축을 풀때 《윈도우 보안》에서 의심스러운 파일 등의 이유로 자동으로 일부 파일을 삭제하는 경우가
있습니다. 그 경우에는 윈도우 보안 설정에서 해당 파일을 격리 해제 시킨 후 다시 압축을 풀어서 사용해야 합니다.
본 소프트웨어는 어떠한 바이러스도 포함하고 있지 않습니다.
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4 프로그램의 동작 원리

4.1 제어점과 참고점

본 프로그램은, 여러개의 제어점을 지정하고 그 점들을 곡선으로 연결합니다. 현악기는 좌우 대칭이므로 악기 몸체의
세로 중앙선을 기준으로 좌측부의 라인을 작도하고 그것을 대칭 복사하여 우측 라인을 완성합니다.

제어점은 악기 몸체의 길이, 좌우폭 등을 결정하기 위한 점들로 이 점들을 연결하여 몸체 곡선을 완성하게 되며,
참고점은 계산과 분석을 위한 점입니다. 사용자는 점의 위치를 직접 지정하지 않고 악기의 사이즈(높이, 넓이)를
입력하며, 프로그램이 자동으로 제어점과 참고점의 위치를 계산합니다.

제어점을 연결할 때는 멀티클로소이드 곡선을 사용합니다. 멀티클로소이드 곡선은 3개의 클로소이드 곡선이 G2

에르미트 보간법(G2 Hermite lnterpolation)을 사용하여 하나로 연결된 곡선이며, 3개의 곡선은 각각 다른 색상으로
표시됩니다. 점의 위치를 변경하거나 멀티클로소이드 곡선의 파라미터값을 바꾸면 곡선의 모양이 바뀌게 됩니다.

Figure 1: 제어점(적색점)과 참고점(녹색점)
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4.2 클로소이드 곡선

클로소이드 곡선이란 곡선 길이가 증가할수록 곡률이 커지는 곡선을 의미합니다. 즉, 곡선의 곡률 이 점점 커져서
갈수록 더 동그랗게 말려들어가는 모습의 곡선입니다. - Figure.2 (a) -

이러한 클로소이드 곡선은 일정한 속도로 달리는 자동차의 핸들을 일정한 속도로 회전시켰을 때 자동차가 이동하는
궤적과 일치하기 때문에 주로 고속도로의 커브 구간에 완화 곡선으로 주로 사용됩니다. Figure.2(b) 의 붉은 선이 클로
소이드 곡선입니다. 고속도로로 예를 들자면, 파란색의 직선 도로에서 녹색의 원형 도로로 들어가려할 때 클로소이드
곡선을 따라 점진적으로 회전 반경을 줄여나가는 것입니다.

(a)클로소이드 곡선 (b)고속 도로의 클로소이드 곡선

Figure 2: 클로소이드 곡선
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4.3 멀티클로소이드 곡선

고정된 위치의 두 제어점을 클로소이드 곡선으로 연결할 때, 두 제어점에서의 곡선 방향이 변하지 않는다면 그 두
제어점을 연결하는 클로소이드 곡선은 단 하나만 존재하게 됩니다. 이 문제는 바이올린 디자인시에는 큰 문제가
됩니다. 왜냐하면 악기의 사이즈가 같다면(제어점의 위치가 같다면) 단 하나의 디자인만 만들 수 있기 때문입니다.

Figure.3(a) 는 점 A 와 B 를 하나의 클로소이드 곡선이 연결하고 있는 모습니다. 이 곡선은 점 A 와 B 에서 곡선의
방향이 바뀌지 않는한 절대로 모양이 바뀌지 않습니다. Figure.3(b) 는 점 A 와 B 를 멀티클로소이드 곡선으로 연결한
것으로, 점 A 와 B 에서 곡선의 방향은 그대로 유지하면서 곡률만을 바꾼 것입니다. 그림에서 보듯, 무수히 많은
모양의 곡선을 생성할 수 있습니다. 즉, 멀티클로소이드 곡선을 이용하면 제어점의 위치와 곡선의 방향을 바꾸지
않고도 다양한 모양의 곡선을 생성할 수 있습니다.

(a)단일 클로소이드 곡선 (b)멀티클로소이드 곡선

Figure 3: 단일 클로소이드와 멀티클로소이드 곡선

본서에서 말하는 멀티클로소이드 곡선은, 《G2 에르미트 보간법》이라는 방법을 이용하여 3개의 단일 클로소이드
곡선을 이어붙여서 하나의 곡선으로 만든 것을 말하며, 3개의 단일 클로소이드 곡선들은 시각적으로 확인할 수 있도록
각기 다른 색으로 표현하고 있습니다.
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4.4 멀티클로소이드의 모양 변경

어떤 두 개의 점이 멀티클로소이드 곡선으로 연결되어 있을 때, 그 곡선의 모양은 각 점에서의 멀티클로소이드 곡선의
《방향》과 《곡률》에 의해 결정됩니다.

■ 방향

곡선이 향하는 방향(각도, 동쪽=0◦)에 따라 곡선의 모양이 바뀝니다. Figure.4은 출발점과 도착점에서 방향이 다른
멀티클로소이드 곡선의 모양을 나타내고 있습니다. 좌측 그림은 272◦방향을 향해 출발하고 있으며 중앙 그림은 300◦

방향을 향해 출발하고 있습니다. 우측 그림은 도착점에서의 방향이 다른 경우입니다. 주의할 점은, 곡선의 방향은
항상 《진행 방향을 기준》으로 한다는 점입니다. 중앙 그림에서 도착점 B에서의 곡선의 방향은 231◦이며 우측 그림의
방향은 200◦입니다.

Figure 4: 곡선 방향 변화에 따른 멀티클로소이드 곡선의 모양 변화

※ 주의 ※
위에서 설명한 각도 계산은 모두 좌측 곡선에만 적용됩니다.
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■ 곡률 (절대값의 크기와 부호)

곡률은 곡선의 휨 정도를 결정하는 값으로써 곡률(절대값)이 크면(=곡률 반경이 작으면) 급격하게 휘고, 작으면
완만하게 휘게 됩니다. 또한 +/- 부호는 휘는 방향을 결정합니다. 곡률의 부호가 + 일 때에는 진행 방향에 대해서
좌측으로 휘며, 부호가 - 일 때에는 우측으로 휘게 됩니다.

Figure.5 는 출발점 A에서 방향이 같고 곡률의 값(절대값)과 부호가 바뀔 때 곡선이 어떻게 변화하는지 보여줍니다.
좌측 그림은 곡률이 -100 일 때의 모습으로, 부호가 - 이므로 진행 방향에 대하여 우측으로 휘고, 곡률의 절대값이
크므로 급격하게 휘어 있습니다. 반면에 우측 그림은 곡률이 +100 일 때의 모습으로 부호가 + 이고 절대값이 크므로
진행 방향에 대하여 좌측으로 급격하게 휘어 있습니다. 가운데 그림은 곡률이 0일 때의 모습으로 정해진 진행 방향에
대하여 휘어짐 없이 곧게 뻗어있음을 알 수 있습니다.

Figure 5: 곡률의 부호와 절대값 변화에 따른 멀티클로소이드 곡선의 모양 변화

※ 주의 ※
위의 각도와 마찬가지로 모두 좌측 곡선에만 적용되며 우측 곡선에서는 곡률의 부호가 반대가 됩니다.
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5 화면 설명

5.1 메인 윈도우

※ v.3.0.0 에서, UI 모양과 위치, 용어 및 내용이 일부 변경되었습니다.

[메인 윈도우]는 총 5개의 구역으로 구분되며 각각 다음과 같은 역할을 합니다.

• Area (A): 도면 이름 설정, 프리셋 적용 버튼, 제어점과 참고점의 설명 이미지
• Area (B): 도면 작성을 위한 기본 설정과 악기 사이즈 설정
• Area (C): 8개 멀티클로소이드 곡선의 모양 설정
• Area (D): 작성된 도면에 표시할 항목을 선택
• Area (E): 도면 그리기 및 파일 저장 버튼

Figure 6: 메인 윈도우
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5.2 결과 윈도우

※ v.3.0.0 에서, 참고이미지도 표시되도록 변경되었습니다.

[메인 윈도우]에서 [Calculate & Draw] 버튼을 눌렀을 때 모니터에 표시되는 [결과 윈도우]입니다. 모니터에 표시된
모든 내용은 동일한 모습(또는 내용)으로 PDF, DXF, TXT파일로 저장할 수 있습니다. [결과 윈도우]의 좌측에는 점과
곡선, 값 및 참고 이미지가 표시되며 우측에는 설정값과 분석값 등이 표시됩니다. 여기에 표시되는 항목들은 [메인
윈도우]의 LAYER (Area D) 항목에서 켜거나 끌 수 있습니다.

Figure 7: 결과 윈도우
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5.3 참고 이미지 설정 윈도우

※ v.3.0.0 에서, 추가되었습니다.

악기의 사진을 보면서 해당 악기의 모양을 참고하여 디자인하거나 또는 사진을 그대로 본따고자 할 때 사용합니다.

[메인 윈도우]의 상단 메뉴에서 [Tools>Reference Image] 를 클릭하면 실행되며, 미리 준비한 악기 사진을 불러들인
후에 위치와 크기 등을 조절합니다. 또한 악기의 사이즈를 측정할 수 있도록 여러개의 참고선을 설정할 수 있습니다.

Figure 8: 참고 이미지 설정 윈도우

• Guide-h1/2/3: 높이 참조를 위한 수평 참고선
• Guide-w1/2/3: 넓이 참조를 위한 수직 참고선
• Guide-Arc: 뒷판의 상단 끝 지점을 찾기위한 원호 참고선
• Move/Rotate/Zoom Image: 참고 이미지의 이동/회전/확대,축소 버튼
• Draw Image: [참고 이미지 결과 윈도우]를 표시
• Reset Image: 참고 이미지를 초기 모습으로 되돌림 (이동/회전/확대,축소된 이미지를 처음 상태로 되돌림)
• Clear All: 이미지를 포함한 모든 값을 삭제

※ Guide-w1/2/3 의 경우, x=0 을 기준으로 좌우측에 두개의 선이 그려지며 그 두개선의 폭, 즉 입력값의 2배가 자동
계산되어 w=0.00 과 같이 표시됩니다.
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5.4 참고 이미지 결과 윈도우

※ v.3.0.0 에서, 추가되었습니다.

[참고 이미지 설정 윈도우]에서 이미지를 불러들인 후, [Draw Image] 버튼을 클릭했을 때 나타나는 [참고 이미지의
결과 윈도우]입니다. 이 화면을 보면서 실시간으로 이미지의 위치와 크기 등을 조정합니다. 설정 윈도우에서 참고선을
켜면 해당 위치에 선이 표시됩니다. 참고 이미지는 항상 흑백으로 표시됩니다.(원본 사진이 컬러인 경우에도 흑백으로
전환하여 표시됩니다)

Figure 9: 참고 이미지 결과 윈도우
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6 전체적인 사용 순서

6.1 참고 이미지 없이 디자인할 때

1. 디자인 이름 입력 (Area A)
2. 프리셋 적용 (Area A, 악기 버튼 클릭)
3. 출력 옵션 수정 (Area D, [결과 윈도우]에 표시할 내용 선택)
4. 기본 조건값 수정 (Area B)
5. 악기 사이즈 수정 (Area B)
6. 곡선 모양 수정 (Area C)
7. 디자인 확인 (Area E, [Calc...] 버튼 클릭)
8. 디자인 수정 (수정 필요시, 위의 5~7번 반복)
9. 디자인 저장 (디자인 확정시, Area E, [Save...] 버튼 클릭)
10. 설정값 저장 (디자인 확정시, [File>Export] 버튼 클릭)

6.2 참고 이미지를 사용하여 디자인할 때

1. 디자인 이름 입력 (Area A)
2. 프리셋 적용 (Area A, 악기 버튼 클릭)
3. 출력 옵션 수정 (Area D, [결과 윈도우]에 표시할 내용 선택, [Ref. Image] 버튼 On)
4. 기본 조건값 수정 (Area B)
5. 참고 이미지 선택 ([Tools>Reference Image] 클릭)
6. 참고 이미지 조정 ([참고 이미지 설정 윈도우]에서 참고 이미지 조정)
7. 악기 사이즈 수정 (Area B)
8. 곡선 모양 수정 (Area C)
9. 디자인 확인 (Area E, [Calc...] 버튼 클릭)
10. 디자인 수정 (수정 필요시, 위의 7~9번 반복)
11. 디자인 저장 (디자인 확정시, Area E, [Save...] 버튼 클릭)
12. 설정값 저장 (디자인 확정시, [File>Export] 버튼 클릭)

6.3 이전의 설정값을 사용하여 디자인할 때

1. 설정값 가져오기 ([Tools>Import] 버튼 클릭)
2. 디자인 수정 (수정 필요시)
3. 디자인 저장 (디자인 확정시, Area E, [Save...] 버튼 클릭)
4. 설정값 저장 (디자인 확정시, [File>Export] 버튼 클릭)
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7 기능 상세 설명

7.1 도움 기능 - Area (A)

본 항목들은 디자인 작업에 도움을 주기 위한 것으로 반드시 사용해야하는 기능은 아닙니다.

■ MODEL NAME

※ v.3.0.0 에서, 위치가 변경되었습니다.

작성하는 도면의 이름을 입력합니다. 여기에 입력된 문자는 [결과 윈도우] 및 저장되는 모든 파일에 기록됩니다.

■ PRESET

※ v.3.0.0 에서, 위치가 모양이 변경되었습니다.

작업 편의를 위해 도입한 기능으로, 원하는 악기 버튼을 클릭하면 미리 설정된 초기값이 적용되어 모든 입력란에 값이
자동으로 입력됩니다. 모든 값을 한꺼번에 삭제하고 싶은 경우에는 [Delete All Value] 버튼을 클릭합니다.

■ POINT GUIDE

많은 종류의 제어점과 참고점을 모두 외울 필요는 없습니다. 이 그림에서 각 점들의 위치를 확인할 수 있습니다.
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7.2 기본 사항 설정 - Area (B)

Area (B), GEOMETRY에서는 프로그램을 사용하기 위한 기본 사항과 악기의 사이즈를 설정합니다. 여기에서는 먼저
기본 사항부터 설정합니다.

■ A. Instrument

바이올린, 비올라, 첼로 중에서 작성하고자 하는 악기를 선택합니다. 이 옵션은 모니터 화면에 표시되는 [결과 윈도우]
와 PDF 파일에 표시되는 그래프의 축 범위를 자동 설정하기위해 사용됩니다.

■ B. Width of Corner & Junction

코너의 폭(X1X2, Y 1Y 2)과 코너 연결점의 폭(P1P2, Q1Q2)을 결정하는 방법을 선택합니다. 기존의 다른 디자인
방법들은 바이올린에 사용한 방법을 첼로나 비올라와 같은 큰 악기에는 적용할 수 없어 범용적인 방법이 아니라는
공통적인 문제를 지니고 있습니다. ( 코너: X1, X2, Y1, Y2, 코너 연결점: P1, P2, Q1, Q2 )

이 문제를 해결하기 위해 본 프로그램에서는 악기의 크기에 상관없이 범용적으로 사용할 수 있는 방법(Method of

H.I.S.)을 새로 고안하여 적용하였습니다. 코너 연결점의 위치는 항상 코너의 수직선상에 위치하며, 따라서 코너의
폭과 코너 연결점의 폭은 항상 동일합니다. (즉, X1X2=P1P2, Y 1Y 2=Q1Q2)

※ 이 방법은 악기 크기에 상관없이 준수한 결과를 보여주지만 그것이 가장 아름답다거나 가장 좋은 소리를 보장하지는
않습니다. 이 방법은 아직 코너의 폭을 결정하지 못했을 때, 또는 디자인의 출발점으로 사용하시기 바랍니다.

[Auto (Method of H.I.S)] 를 선택하면 코너(및 코너 연결점)의 폭이 자동으로 계산되며, [Use My Value] 를 선택하면
사용자가 직접 입력한 값(Area (B) 의 13,14,15,16번 항목)을 사용하게 됩니다. 아래는 [Auto (Method of H.I.S)]의 계산
원리입니다. - Figure 10 -

※ 코너와 코너 연결점의 위치 결정 방법 (Method of H.I.S)

1. 점 U1과 L1를 잇는 직선을 긋는다.
2. 점 X에서 X와 U의 거리의 두배가 되는 세로중앙선 위의 지점을 찾는다. 이 점을 K라 한다.
3. 점 K를 지나는 수평선과 위의 1번에서 작성한 사선의 교차점을 찾는다. 이 점을 R이라 한다.
4. 점 R에서 아래로 내린 수선과 점 X를 지나는 수평선의 교차점을 찾는다. 이 점을 X1으로 하며, X1은 상단

코너의 위치가 된다.
5. 점 P를 지나는 수평선과 점 X1을 지나는 수직선의 교차점을 찾는다. 이 점을 점 P1으로 하며, P1은 상단 코너

연결점의 위치가 된다.
6. 점 X1과 L1을 잇는 직선을 긋는다.
7. 점 Y를 지나는 수평선과 위의 5번에서 작성한 사선의 교차점을 찾는다. 이 점을 Y1으로 하며, Y1은 하단

코너의 위치가 된다.
8. 점 Q를 지나는 수평선과 점 Y1을 지나는 수직선의 교차점을 찾는다. 이 점을 점 Q1으로 하며, Q1은 하단 코너

연결점의 위치가 된다.
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Figure 10: 코너와 코너 연결점의 위치 결정 방법 (Method of H.I.S.)

따라서, 상단 코너의 폭(X1X2)은 X와 X1거리의 2배, 하단 코너의 폭(Y 1Y 2)은 Y와 Y1거리의 2배입니다. 그러나
위의 2번에서, 만약 X와 U의 거리의 두배가 되는 지점 K가 점 A보다 더 위에 있는 경우(2*UX>AX ,또는 KX>AX

의 경우)에는 점 A 를 K 로 사용합니다. 바꾸어 말하면 (K 의 y 좌표 최대값) = (A 의 y 좌표값) 입니다. 이것은 주로
점 U 와 X 의 거리가 먼 첼로와 같은 큰 악기에 나타나는 현상입니다.

[Auto (Method of H.I.S)] 방법으로 결정된 코너의 폭은, U-Bout의 폭과 L-Bout의 폭의 차이 및 UX 와 Y L 의 길이에
영향을 받습니다. U-Bout 의 폭과 L-Bout 의 폭의 차이가 클수록 코너의 폭은 좁아지고, 또한 UX 와 Y L 의 길이가
길수록 코너의 폭이 좁아집니다. (점 P와 Q의 높이는 자동으로 계산되는 것이 아니므로 직접 위치를 지정해야 합니다
(n.8,9). 즉, 점 P 의 위치를 조금 더 위로 올리면 점 P1 의 위치도 위로 올라가게 됩니다.)
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■ C. Set axes

[결과 윈도우]에 표시되는 가로, 세로 축의 범위를 설정합니다. 자동 설정 또는 수동 설정 중에서 선택할 수 있으며,
[Auto] 를 선택한 경우에는 선택된 악기의 크기에 맞게 축의 범위가 자동으로 설정됩니다. 수동으로 설정하고 싶은
경우에는 [Use My Value] 를 선택하고 바로 아래에 있는 입력란에 원하는 축의 범위를 입력합니다. X 축과 Y 축의
최소, 최대값을 입력하며, 축의 단위는 [mm] 이므로 바이올린 몸체의 세로 길이가 355mm 라면 Y축은 최소값은 0

보다 조금 작게, 최대값은 355 보다 크게 설정해야 전체 곡선을 표시할 수 있습니다.

■ D. Set Canvas Size

[결과 윈도우]의 캔버스의 크기를 설정합니다. 이것은 모니터의 해상도를 참고하여 설정하여야 합니다. 만약 자신의
모니터 해상도가 [1024 * 768] 이라면 허용가능한 최대 캔버스 크기는 약 [10 * 7.7]입니다. 즉, 캔버스 사이즈의 값 ‘1’
은 모니터 해상도 100dpi 에 해당합니다.

자동 [Auto] 또는 수동 [Use My Value] 중에서 선택할 수 있으며 자동의 경우 세로 길이는 ‘10’ 으로 지정되고, 가로
길이는 축 범위에 비례하여 자동 조정 됩니다. 따라서 자신의 모니터 해상도가 낮은 경우에는 수동 설정을 사용하는
것이 좋습니다.
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7.3 악기 사이즈 설정 - Area (B)

Area (B), GEOMETRY 에서 악기 사이즈를 설정합니다. 악기 사이즈는 제어점과 참고점의 위치에 의해 결정됩니다.
Area (A) 의 설명 이미지를 참고하여 원하는 값을 입력합니다. 단, 이 값들은 모두 몰드의 사이즈를 의미하므로 악기의
실제 앞/뒷판의 사이즈를 입력해서는 안됩니다. 예를 들면, 실제 제작하기 원하는 바이올린의 몸체 길이가 355 이고
에지폭을 3.5 로 하고자 하는 경우, 몰드의 길이는 355 - 2 * 3.5 = 348 이므로 [2.(AZ) Length of Mould] 에 348 을
입력해야 합니다. 마찬가지로 실제 악기의 U-Bout 의 폭을 170 으로 하고 싶다면 몰드의 폭은 170 - 2 * 3.5 = 163

이므로 [10.(U1U2) Width of U-Bout] 에 163 을 입력해야 합니다.

[1.(EA) Width of Edge ] 에서 (EA) 는 점 E와 A의 거리를 지칭하는 약어이며, 메인 윈도우에서 괄호 안에 적힌 문자는
점과 점의 거리를 의미하고 있습니다. [13.(X1X2)Width of U-Corner(Xw)] 에서 (X1X2) 는 점 X1 과 점 X2 의 거리를
뜻하며, (Xw) 는 그것을 간단히 표현한 약어입니다. (결과 윈도우에서는 Xw 와 같은 약어로 표시됩니다)

위의 설명을 참고하여 1.(EZ)... 부터 16.(Q1Q2)... 까지 16개 항목에 모두 값을 입력합니다.(프리셋을 이용하여
한꺼번에 자동 입력 후 수정하는 것이 편리)
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7.4 곡선 설정 - Area (C)

Area (C), CURVES 에서는 곡선의 모양을 결정합니다. 몰드 라인은 세로중앙선을 기준으로 좌우대칭이므로, 본
프로그램에서는 좌측부의 곡선을 작성한 후 대칭 복사하여 우측부 곡선을 완성합니다. 따라서 모든 설명은 좌측부
곡선에 대한 설명입니다. 좌측부는 총 8개의 멀티클로소이드 곡선으로 구성되어 있으며, 이 곡선들은 앞단계에서
설정한 제어점들을 연결합니다.

Figure.11 는 좌측부 8개의 곡선을 표시하고 있습니다. 점 A 와 U1 을 잇는 곡선을 Curve 1, 점 U1 와 P1 을 잇는
곡선을 Curve 2, ... 이러한 방식으로 위에서부터 순서대로 번호를 부여하고 있습니다. 또한 4.4 장에서 설명한 바와
같이, 멀티클로소이드 곡선은 시작과 끝이라는 개념을 가지고 있으며 항상 위에 있는 점에서 시작(출발)하여 바로
아래에 있는 점에서 끝납니다. 아래는 곡선에 관련한 약어와 설명입니다.

• Curve 1. (AU1) : 점 A 에서 시작해서 점 U1에서 끝나는 1번 곡선
• S.Ang.(A): 시작점(Start) A 에서의 각도(Angle)
• Cur.(A): 시작점(Start) A 에서의 곡률(Curvature)
• E.Ang.(U1): 끝점(End) U1 에서의 각도(Angle)
• Cur.(U1): 끝점(End) U1 에서의 곡률(Curvature)

이처럼, 하나의 멀티클로소이드 곡선을 설정하는데는 4개의 값이 필요합니다. 시작점에서의 각도(방향)와 곡률,
그리고 끝점에서의 각도(방향)와 곡률입니다. 그러나 그 중 일부는 바꿀 수 없는 정해진 값만을 사용해야 하는 것이
있습니다. 예를 들면 1번 곡선의 시작점에서의 각도는 반드시 180◦가 되어야하며 끝점에서의 각도는 반드시 270◦가
되야 합니다. 이러한 고정값들은 사용자가 수정할 수 없습니다.

Figure 11: 8개의 멀티클로소이드 곡선
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각도와 곡률 입력란의 왼쪽에는 ( 270 ≤ X ≤ 300 ) 와 같이 입력 가능한 범위가 표시되어 있습니다. 이 범위 밖의
숫자를 입력해도 곡선을 작성할 수 있지만 에러메세지가 표시됩니다. 이 범위는 대략적인 추천 범위로서 이 범위를
넘어서면 극단적인 모양의 곡선이 생성됩니다.

이러한 곡선들의 모양을 조정하기 위해서는 멀티클로소이드 곡선의 원리를 잘 알아야 하므로 4.4장의 설명을 충분히
읽어보시기 바랍니다.

아래에는 1~4번 곡선에 대한 간단한 설명입니다. 5~8번 곡선은 이와 유사하므로 설명을 생략합니다.

■ Curve 1. (AU1)

시작점 A 에서의 각도는 180◦이며 고정값입니다. 이 지점에서는 좌우 두 개의 곡선이 수평으로 만나야 하므로
반드시 각도는 180◦이어야 합니다. 끝점 U1에서는 두 개의 곡선이 서로 수직으로 만나야 하므로 반드시 각도는 270◦

이어야하며 고정값입니다. Figure 12 를 보면, 곡률이 커지면 전체 곡선이 더 둥글게 변함을 알 수 있습니다. 이러한
성질을 이용하여 자신이 원하는 곡선을 생성합니다.

(a) S.Cur.(A): 0.0, E.Cur.(U1): 0.0 (b) S.Cur.(A): 0.0, E.Cur.(U1): 13.0

(c) S.Cur.(A): 4.0, E.Cur.(U1): 10.0

Figure 12: 1번 곡선의 파라미터 설정

■ Curve 2. (U1P1)

시작점 U1에서의 각도는 270◦로 고정값이며 이것은 1번 곡선의 끝점의 각도와 일치합니다. 더 매끄러운 곡선을
위해서는 이곳의 곡률을 1번 곡선의 끝점 곡률과 비슷하게 설정하는 것이 좋습니다. 끝점 P1에서는 대략 남남동
방향을 향하므로 각도는 [270 < x ≤ 300] 범위 내에서 입력합니다.
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■ Curve 3. (P1X1)

시작점 P1 에서의 각도는 반드시 2번 곡선의 끝점의 각도와 일치해야 합니다. 따라서 이 값은 위에서 입력한 값이
자동으로 입력됩니다. 이렇게 이전의 곡선의 값을 그대로 가져오는 경우에는 입력란 좌측에 [connected] 라는 표시가
붙습니다. 이곳의 곡률은 [−50 ≤ x ≤ 50] 범위 내에서 입력하도록 되어있지만 일반적으로 이 값이 ‘0’ 부근일 때
가장 자연스러운 곡선을 얻을 수 있습니다.

3번 곡선의 끝점과 4번 곡선의 시작점의 파라미터는 상단 코너의 형상을 결정하게 되므로 신중하게 정해야 합니다.
두 곡선의 각도에 따라 코너 정점 모서리가 향하는 방향과 뾰족한 정도가 결정되며, 곡률은 코너 정점 부근의 선의
모양과 뾰족한 정도를 결정합니다. Figure 13 의 (a) 와 (c) 를 비교하면 각도와 곡률이 모두 다르지만 곡선의 깊이는
대체적으로 비슷합니다. 그러나 (a) 는 정점에서 즉시 휘어지며 (c)는 정점에서 쭉 뻗어있는 모습입니다.

(a) Ang.:230.0, Cur.:−100.0 (b) Ang.:245.0, Cur.:−100.0 (c) Ang.:245.0, Cur.:0.0

Figure 13: 3번 곡선 끝점 X1의 파라미터에 따른 곡선의 변화
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■ Curve 4. (X1M1)

끝점 M1 에서의 각도는 270◦고정값입니다. 3번 곡선의 끝점처럼 시작점 X1 에서의 각도와 곡률은 코너의 모양을
결정하는 중요한 요소입니다. 또한 끝점 M1 에서의 곡률은 C-Bout 의 모양을 결정하며 ‘0’ 에 가까울수록 C-Bout 은
중앙이 평평한 모양이 됩니다.

(a) Ang.:18.0, Cur.:−70.0, E.Cur.:−10.0 (b) Ang.:14.0, Cur.:0.0, E.Cur.:−10.0 (c) Ang.:14.0, Cur.:0.0, E.Cur.:0.0

Figure 14: 4번 곡선의 파라미터에 따른 곡선의 변화
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7.5 레이어 설정 - Area (D)

Area (D), LAYER에서는 모니터의 [결과 윈도우]와 PDF파일에 표시/저장할 내용을 선택합니다. 체크 박스를 선택하면
표시/저장되고 선택하지 않으면 표시/저장되지 않습니다. DXF파일은 체크 박스의 선택 여부와 관계없이 모든 내용이
저장되며, 선택하지 않은 내용은 [Layer Off] 상태로 처리되어 캐드 프로그램에서 해당 파일을 열었을 때 보이지 않게
되지만, 캐드 프로그램에서 해당 Layer 를 On 상태로 바꾸면 나타나게 됩니다.

■ Mould Outline

몰드 외형선을 표시/저장합니다. 가장 기본적인 내용이며 본 프로그램의 목적이 이 곡선을 작도하는 것이므로 가장
중요한 라인입니다. 프로그램 실행시 기본으로 선택되어 있습니다. - Figure 15 -

■ Edge Line, Corner Arc

[Edge Line] 는 몰드 외형선의 바깥쪽에 있는 앞판/뒷판의 엣지 라인입니다. 이 곡선은, [1.(EA) Width of Edge] 에서
설정한 값만큼 몰드 외형선을 바깥쪽으로 이동(Offset)하여 만들어집니다. [Corner Arc] 는 코너 꼭지점에서 해당 값을
반지름으로 하는 원호를 그립니다. 이 원호는 코너 디자인시 참고용으로 사용할 수 있습니다. - Figure 15 -

(a) Mould Outline (b) Mould Outline + Edge Line (c) Mould Outline + Edge Line+ Corner Arc

Figure 15: Mould Outline, Edge Line, Corner Arc
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■ Point, Name, Value

제어점과 참고점을 표시합니다. 점과 이름, 값을 각각 독립적으로 표시할 수 있습니다.

[결과 윈도우]에서, 중앙의 참고점 우측에 있는 값(적색 상자)은 점 Z와의 거리를 나타냅니다. 예를 들어 점 [Q 117.4]
는, 점 Q 와 Z 의 거리가 117.4[mm]임을 의미합니다. U2 우측의 [Uw 160.0] 은 점 U1 과 점 U2 의 거리, 즉, U-Bout
의 폭이 160.0[mm] 임을 의미합니다(노란색 상자).

코너의 좌측과 대각선 부근에 있는 [a,d,r,c] 는 코너에 관련한 값(초록색 상자)이며(아래의 ‘코너의 각도/기울기’ 참고).
코너 우측의 [w,h] 는 코너 블럭의 사이즈를 의미합니다(파란색 상자). 이 값은 참고일 뿐이므로, 실제 악기 제작시
코너 블럭의 사이즈는 제작가 본인이 결정할 사항입니다.

Figure 16: 결과 윈도우에 표시되는 값들 - 노란색:폭, 적색:거리(높이), 파란색:블럭사이즈, 초록색:코너
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■ Guide Line, Center(V), Center(H), Block

여러가지 참고선을 켜거나 끌 수 있습니다.

• Guide Line: 제어점을 지나는 수평/수직선
• Center(V/H): 가로,세로 중앙선(악기의 물리적 중앙선)
• Block: 코너 블럭과 수평선

(a) Guide Line (b) Center(V),(H) (c) Block

Figure 17: Guide Line, Center, Bloc
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■ Corner Ref.

[Corner Ref.](Corner Reference) 은 코너 점 X1과 L1을 잇는 직선으로 상단 코너와 하단 코너의 폭을 직관적으로 비교
확인하기 위한 표시선입니다. Figure.18 (a) 는 코너의 폭을 자동(Method H.I.S.)으로 설정한 경우로 그 원리에 따라
점 X1 와 L1 을 잇는 직선 위에 Y1 이 위치합니다. 반면, 그림 (b) 는, 수동(Use My Value)으로 설정하고 상단 코너의
폭은 더 넓게, 하단 코너의 폭은 더 좁게하여 작성한 예입니다.

(a) Auto(Method H.I.S.)로 설정한 경우 (b)수동으로 코너 폭을 수정한 경우

Figure 18: Corner Ref. 표시선
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■ Corner Ang.

[Corner Ang.](Corner Angle) 는 코너의 각도 및 각도 측정 반지름, 기울기선을 표시합니다. Figure.19 (a) 는 [Corner
A.] 만 켠 상태이며, 그림 (b) 는 [Guide Line] 도 함께 켠 상태입니다. 그림 (b) 를 보면 상하단 코너는 둘 다 U/L-Bout

의 제일 넓은 지점보다 조금 위쪽을 향하고 있다는 것을 알 수 있습니다.

(a) Corner Ang.만 표시 (b) Corner Ang. 와 Guide LIne 을 표시

Figure 19: Corner Ang.

코너에 대한 자세한 설명은 다음 내용을 참고하시기 바랍니다.
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※ 코너의 각도(벌어진 정도)

현악기의 코너는 직선이 아닌 두개의 곡선에 의해 생성되며, 이러한 두개의 곡선이 이루는 각의 크기, 즉 두 곡선이
얼마나 벌어져있는지 판단하거나 표현하는 것은 상당히 까다로운 일입니다. 본 프로그램으로 디자인하는 경우에는
해당 지점에서의 두개의 멀티클로소이드 곡선이 가진 방향(각도)값으로 설명할 수 있지만, 이는 코너를 무한히 확대
하였을 때 코너의 꼭지점에서만 성립되는 값이므로 우리 인간이 시각으로 느끼는 각도와는 많은 차이가 있습니다.

Figure 20 은 코너를 이루는 선이 직선일 때와 곡선일 때의 각도를 설명하고 있습니다. 직선의 경우에는 측정 위치에
상관없이 각도가 일정하지만, 곡선의 경우는 측정 위치에 따라 각도가 달라짐을 알 수 있습니다. 그러나 이러한 현악기
코너의 특성에도 불구하고 우리 인간의 눈은 서로 다른 두 개의 코너 중에서 어느 쪽이 더 둔각인지 또는 예각인지
직관적으로 판단할 수 있는 능력을 가지고 있습니다.

(a)직선 코너 (b)곡선 코너

Figure 20: 코너 각도의 차이

인간이 느끼는 각도의 크기는 사람마다 다르겠지만, 디자인 작업을 위해서는 코너의 벌어진 정도를 측정하는 어떤
기준이 필요합니다. 즉, 코너의 꼭지점에서 어느 만큼 떨어진 곳(각도 측정 반지름)에서 각도를 측정할지가 결정되어야
합니다. 또한 악기의 크기에 상관없이 측정점의 위치를 결정하는 그 윈리는 동일해야 합니다.

악기의 전체적인 크기가 커진다면 꼭지점에서 측정점까지의 거리(각도 측정 반지름)도 커져야 할 것입니다. 그러나
악기의 전체 크기는 커졌지만 코너를 포함한 C-Bout 의 모양과 크기가 동일하다면 각도 측정 반지름도 동일해야 할
것입니다. 즉, 각도 측정 반지름은 악기의 길이나 폭에 완벽히 비례한다고는 말할 수 없습니다. 마찬가지로, 악기의
크기가 작아졌지만 코너의 모양과 크기는 동일하고 오직 위아래에 있는 두개의 코너 간격만 좁아진 것이라면 이또한
각도 측정 반지름은 동일해야 할 것입니다. 이러한 점들로 미루어보아, 각도 측정 반지름의 크기는 코너 가까이에
있는 국부적인 곡선들에게서만 영향을 받는다고 추측할 수 있습니다.

코너 가까이에 있는 국부적인 곡선이라면 결국 코너 자신을 포함한 위아래의 두개의 곡선을 들 수 있습니다. 상단부
코너를 기준으로 설명하자면 3번과 4번 곡선입니다. 여기서 4번 곡선(C-Bout)은 길이가 길고 곡선의 휨방향이 일정
(오른쪽 또는 왼쪽)하기에 기준으로 삼기 어렵습니다. 나머지 한쪽(3번 곡선)은 코너의 꼭지점에서 얼마 떨어지지
않은 곳에서 곡선의 휨방향이 변하는 지점(점 P1)이 있으므로 기준으로 삼기에 최적으로 볼 수 있습니다. Figure 21

의 곡선 P̃1X1 이 바로 그것입니다.
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Figure 21: 코너의 각도 측정 기준(반지름)과 각도 및 기울기

실제로 코너를 디자인 할 때, 곡선 P̃1X1 의 길이에 따라 코너의 전체적인 크기가 변하게 되며, C-Bout쪽(4번 곡선)의
코너 곡률은 곡선 P̃1X1 의 곡률과 유사하도록 설계하게 됩니다. 경우에 따라서는 C-Bout 쪽의 코너 곡률에 맞춰서
곡선 P̃1X1 의 곡률이 결정되기도 하지만, 어찌되었든 꼭지점 부근에서의 두 곡선의 곡률은 서로 비슷한 모양으로
결정되므로, 코너의 모양은 곡선 P̃1X1 의 모양(길이와 곡률)에 크게 영향을 받는다고 말할 수 있습니다. 따라서
코너 각도 측정 반지름 역시 곡선 P̃1X1 를 기준으로 결정할 수 있을 것이며, 정확히는 점 P1 과 X1 의 직선거리를
기준으로 하는 것입니다. 즉, 직선 P1X1 의 길이를 일정 비율로 나누었을 때의 값을 코너 각도 측정 반지름으로
사용하는 것입니다.

여러 비율로 시험해 본 결과, 직선 P1X1 길이의 1/3 을 코너 각도 측정 반지름으로 설정하는 것이 가장 바람직하다고
결론을 내렸습니다. 이 값을 사용하면, 본 프로그램에 설정되어있는 바이올린과 비올라 및 첼로 디자인 프리셋의 각도
측정 반지름은 바이올린:8.8mm, 비올라:9.3mm, 첼로:15.3mm 가 되며, 만약 P1X1 가 더 길어진다면 이 값들은 더
커질 것입니다.

이러한 방법으로 각도 측정 반지름을 결정한 후, 코너의 꼭지점에서 해당 반지름의 원을 그리고, 그 원과 코너 곡선이
만나는 두개의 교점(점 L과 M)을 표시합니다. 이 두개의 교점과 코너 꼭지점(점 X1)이 이루는 각도(∠LX1M)를 해당
코너의 각도로 정의하게 됩니다. Figure 21 에서는, r 이 각도 측정 반지름이며 a 는 코너가 벌어진 정도, 즉 코너의
각도입니다.

하나의 악기에서 코너를 비교할 때는 상하 코너 둘 다 동일한 기준을 사용해야하므로, 상단 코너에서 각도 측정
반지름을 결정한 후에 하단 코너에서도 동일한 각도 측정 반지름을 사용하여 각도를 측정합니다.
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※ 코너의 기울기(방향)

코너의 각도와 함께, 코너의 꼭지점이 어느 방향을 향하고 있는지, 즉 코너의 기울기를 알고 싶을 때가 있습니다. 이
기울기에 따라서 코너가 C-Bout 의 안쪽으로 모이기도하고 밖으로 벌어지기도하기 때문입니다. 코너의 기울기를
판단하는 것은 비교적 쉽습니다. 앞에서 코너의 각도가 결정되었으므로 그 중앙선을 찾으면 됩니다. Figure 21 에서,
직선 LM 의 중점 N 과 꼭지점 X1 을 지나는 직선이 수평선과 이루는 각도가 코너의 기울기(d: ∠NX1X3)입니다. 이
값은, 상단 코너는 ’+’값을 가지며 하단 코너는 ’-’값을 가지게 됩니다. 한가지 주의할 점은, 코너의 기울기값은 코너
각도의 1/2 이 아니라는 것입니다(d ̸= a/2). 코너의 기울기는, 수평선(직선 X1X3)에 대해서 코너 각도의 중심선이
얼마나 기울어져있는지 나타내는 값이기 때문입니다.

Figure 22: 코너의 기울기선과 세로중앙선의 교점

코너의 기울기(d) 값만으로는 얼마나 기울어져있는지 직관적으로 이해하기가 어렵습니다. 이때 도움을 주는 것은
코너의 기울기선(코너 각도의 중심선)입니다. 즉 코너의 기울기를 나타내는 선을 길게 연장하면 악기의 세로중앙선과
만나게 되는데, 이 교점(Figure 22의 점 C)의 위치를 참고하면 코너의 기울기를 더 쉽게 판단할 수 있습니다. 이 교점은,
일반적으로 상단 코너의 경우에는 U-Bout 의 제일 넓은 지점 부근에 위치하며, 하단 코너는 L-Bout 의 제일 넓은 지점
부근에 위치하게 됩니다.

※ 값의 표시

[LAYER] 항목의 [Value] 를 체크하면 [결과 윈도우]에 코너에 관련한 모든 값들이 표시되며, [Corner Ref./Ang.] 를
체크하면 관련 선들이 표시됩니다. Figure 16에서 초록색 상자는 코너 관련 값을 나타냅니다. 코너 각도 측정 반지름은
r,코너 각도는 a,코너 기울기는 d,교점은 c로 표시됩니다. 단, 코너의 각도 측정 반지름 r은 상하단이 항상 동일합니다.
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■ Arch Profile

※ v.3.0.0 에서, 추가되었습니다.

[Arch Profile] 은 6개의 아치 프로파일의 위치를 표시합니다. 이는 세로중앙선과 U/L-Bout 의 제일 넓은 곳, 상하단
코너의 가장 좁은 곳, 그리고 상하단 코너의 중간지점1의 위치를 표시합니다. [결과 윈도우]에는 이 표시선들의
위치값(점 Z 와의 거리)과 해당 지점에서의 넓이가 표시됩니다. 이는 최근 발표한 [Violin Arch Designer, v.1.0.0]
프로그램과의 연계를 위한 기능이며, 본 프로그램에서 악기의 몰드 외형선을 디자인하고, 각 지점의 폭에 따라 [Violin
Arch Designer, v.1.0.0] 를 이용하여 아치 프로파일을 작성할 수 있도록 하기 위함입니다.

Figure 23: Arch Profile

1C-Bout 의 가장 좁은 곳으로 선택하는 경우도 있으나 여기에서는 상하단 코너의 중간지점으로 합니다.
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■ Text Box

디자인에 사용된 악기의 사이즈와 곡선의 파라미터, 각 부위의 비율 등 모든 입력값과 분석값을 표시합니다. Text

Box 를 표시하고자 하는 경우에는 [C. Set axes] 와 [D. Set Canvas Size] 를 [Auto] 로 두는 것이 좋습니다. Text Box

는 캔버스의 크기와 관계없이 일정한 크기를 가지므로 캔버스의 크기를 작게 하는 경우에는 서로 겹쳐보이는 경우가
있습니다.

(a) Set axes, Set Canvas Size의 자동설정 (b) Canvas Size가 작은 경우

Figure 24: ext Box의 표시

■ Axis, Grid

캔버스의 축과 그리드선을 표시합니다. - Figure 25 -

(a) Axis:Off, Grid:Off (b) Axis:On, Grid:Off (c) Axis:On, Grid:On

Figure 25: Axis 와 Grid 의 표시
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■ Ref.Image

※ v.3.0.0 에서, 추가되었습니다.

[참고 이미지 설정 윈도우]에서 설정한 참고 이미지를 표시합니다. 참고 이미지를 보면서 디자인하기 위해서는 이
옵션을 켜야합니다.

(a) Ref.Image: On (b) Ref.Image: Off

Figure 26: Ref.Image 의 On/Off
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■ Overlap/Redraw/New Graph

※ v.3.0.0 에서, 추가되었습니다.

[결과 그래프]를 다시 그릴 때 갱신 방법을 선택합니다. (하나만 선택 가능)

• Overlap Graph: 직전에 표시된 디자인을 지우지 않고, 그 위에 새로운 디자인을 함께 표시합니다. 여러 종류의
디자인을 겹쳐서 비교할 때 사용합니다.

• Redraw Graph: 직전에 표시된 디자인을 지우고, 새로운 디자인을 표시합니다.
• New Graph: 직전에 표시된 결과 그래프를 그대로 두고, 새로운 창을 열어서 표시합니다.

(a)세가지 악기의 비교 (b) C-Bout라인의 비교

Figure 27: Overlap Graph 옵션을 이용한 디자인 비교
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7.6 결과 확인과 파일 저장 - Area (E)

Area (E) 에서는 작성한 디자인을 화면에 표시하거나 파일로 저장할 수 있습니다. [Calculate & Draw] 버튼은 작성한
디자인을 화면에 표시하며, [Save to Files] 버튼은 작성한 디자인을 PDF, DXF, TXT 파일로 저장합니다.

PDF, DXF, TXT 파일은 본 프로그램의 실행파일(Violin_Designer_v.X.X.X.exe)이 위치한 폴더에 생성되며,
[New_Design_yyyy-mm-dd_hh-mm-ss.XXX] 와 같은 파일명으로 저장됩니다.

(a) dxf 파일 (b) txt 파일

Figure 28: 저장된 dxf, txt 파일
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7.7 가져오기와 내보내기

※ v.3.0.0 에서, 추가되었습니다.

■가져오기

과거에 저장해 두었던 설정 파일을 가져와서 완전히 동일한 디자인을 즉시 작성할 수 있습니다. 메인 윈도우에서
[Tools > Import] 버튼을 클릭한 후 설정 파일을 업로드합니다. 설정 파일이 업로드되면 [Calculate & Draw] 버튼으로
즉시 화면으로 확인할 수 있으며 [Save to Files] 버튼을 누르면 PDF,DXF,TXT 파일로 출력할 수 있습니다.

※ 설정 파일은 참고 이미지에 관련한 내용은 가지고 있지 않으므로, 만약 참고 이미지를 사용한다면 [Tools>Reference

Image] 에서 다시 설정해야 합니다.

■내보내기

디자인이 완성되면 [메인 윈도우]에서 [Tools> Export] 버튼을 눌러 현재의 모든 설정값을 파일로 저장합니다. 저장된
설정 파일은 [Import] 기능을 이용해서 차후에 다시 불러들여 사용할 수 있습니다.

※ 참고 이미지에 관련한 설정값은 설정 파일에 저장되지 않습니다.
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7.8 참고 이미지의 사용

※ v.3.0.0 에서, 추가되었습니다.

다른 악기의 모양을 그대로 본따거나 수정 또는 참고하여 디자인하고 싶은 경우에는 악기 사진(참고 이미지)을 업로
드해서 사진을 보면서 디자인할 수 있는 기능입니다.

7.8.1 참고 이미지의 업로드

1. 참고할 악기의 뒷면 사진2 을 준비합니다. 악기 앞면(앞판)은 상단부가 지판에 가려져있고 오래된 악기의 경우
뒤틀림이 많으므로 추천하지 않습니다. 사진은 가급적 큰 사이즈(중간 이상의 해상도)의 사진이 좋습니다.
사진에는 뒷판의 버튼과 엔드핀이 모두 보여야 합니다.

2. 사진이 준비되면 이미지 편집툴(포토샵 등)을 이용하여 뒷판 전체(버튼 및 엔드핀 포함)가 보이고 최대한 여백
없이 잘라내기하여 저장합니다. 만약 악기가 옆으로 누워있는 사진이라면 악기가 세로로 서있도록 회전한 후에
저장합니다. 잘라내기를 할 때는, 악기의 좌우측에는 조금의 여백을 주고, 상하단에는 버튼과 엔드핀에 최대한
가깝게 붙여서 자르는 것이 좋습니다.

3. [메인 윈도우] > [Tools] > [Reference Image] 버튼을 눌러 참고 이미지 설정 윈도우(Reference Image Setting)를
엽니다.

4. [Browse..] 버튼을 눌러 위에서 잘라내기한 사진을 불러옵니다.

2본 사용설명서에서 사용한 악기 사진은 본인의 악기 사진입니다.
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5. [Height of Image] 입력란에 이미지의 세로 길이를 입력합니다. 이 값은 악기의 실제 길이로서, 악기의 몸체
길이와 버튼 및 엔드핀의 길이를 모두 합친 길이입니다. 예를 들면, 버튼과 엔드핀에 최대한 붙여서 잘라내기 한
경우, 악기 몸체 길이 = 355mm, 버튼 높이 = 10mm, 엔드핀 길이 = 8mm 라고 가정할 때 355+10+8=373 이므로
‘373’ 을 입력합니다. 이 값은 정확하지 않아도 되며 대략적인 값을 입력하면 됩니다.

6. [Draw Image] 를 클릭하면 업로드한 이미지가 흑백으로 전환되어 [참고 이미지 결과 윈도우]에 표시됩니다.
참고 이미지는 참고선과의 구별을 쉽게 하기 위하여 항상 흑백으로 표시되며, 원점(x,y=0,0)에는 항상 십자선
(참고선)이 표시됩니다.

Figure 29: 참고 이미지 결과 윈도우
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7.8.2 참고 이미지의 조정

정확한 디자인을 위해서는 앞장에서 업로드한 이미지의 크기와 위치 및 기울기를 정확하게 맞춰줘야 합니다. 예를
들면, 사진에 있는 악기의 실제 몸체 길이가 355.0mm 라면 그래프상에서도 355.0mm 가 되고, 그래프의 좌표축 위에
정확하게 위치하도록 조정해야 합니다. 이렇게 조정된 이미지는 위치와 크기 및 기울기 그대로 메인 윈도우의 결과
윈도우에 표시되므로 이곳에서 정확히 조정해야 합니다.

이미지 조정은 ‘세로중앙선 정렬 > 크기 조정’ 의 순서대로 실시합니다.

※ 이미지를 확대하거나 회전할 때에는 항상 원점 좌표(x,y=0,0)가 기준점이 됩니다. 따라서 기울기를 조절하거나
크기를 조절하는 경우에는 반드시 뒷판의 세로중앙선의 하단 끝단(에지 끝단)이 원점에 위치해야 합니다.

※ 정밀한 조정을 위해서 이미지를 확대하여 작업할 수 있습니다. [참고 이미지 결과 윈도우]의 하단 [돋보기] 버튼과
[이동] 버튼 등을 이용하시기 바랍니다.

A. 세로중앙선 정렬

제일 먼저, 악기의 세로중앙선을 결정해야 합니다. 세로중앙선을 무엇으로 할지는 사용자가 스스로 판단할 문제이며
방법은 3가지 정도가 있습니다.

• A-1: 뒷판이 《2 piece》인 경우, 좌우측 접합 라인
• A-2: 접합 라인이 휘어져 있거나 《1 piece》인 경우, 버튼의 중앙과 엔드핀의 중앙을 연결한 가상의 직선
• A-3: U-Bout 와 L-Bout 의 제일 넓은 곳의 중간점을 연결한 가상의 직선

아래는 위의 세가지 경우에 악기의 세로중앙선을 화면의 중앙에 오도록 정렬하는 방법입니다. 다음 내용을 참고하여
자신이 선택한 세로중앙선이 그래프의 x=0 수선에 일치하도록 조정합니다.
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■ A-1. 좌우측 접합 라인을 세로중앙선으로 선택할 경우

1. 접합 라인의 하단 끝부분(에지 끝)이 원점에 오도록 [Move Image] 버튼을 이용하여 이미지 위치를 조정합니다.

2. 접합 라인의 상단 끝부분(버튼 근처)이 x=0수선에 오도록 [Rotate Image] 버튼만을 이용하여 이미지를 회전합니
다. 단, 앞단계에서 이미 원점 정렬을 마쳤으므로 절대로 이동(상하좌우)해서는 안됩니다. 세로중앙선 정렬이
완료되면 다음 작업(크기 조정)을 진행합니다.

Figure 30: 세로중앙선 정렬 완료
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■ A-2. 버튼의 중간점과 엔드핀의 중간점을 세로중앙선으로 선택할 경우

1. 뒷판의 하단 끝단의 엔드핀 중앙 지점이 원점에 오도록 [Move Image] 버튼을 이용하여 이미지 위치를 조정합니다.

2. 상단 버튼의 중앙 지점이 x=0 수선에 오도록 [Rotate Image] 버튼만을 이용하여 이미지를 회전합니다. 단,
앞단계에서 이미 원점 정렬을 마쳤으므로 절대로 이동(상하좌우)해서는 안됩니다. 세로중앙선 정렬이 완료되면
다음 작업(크기 조정)을 진행합니다.

Figure 31: 세로중앙선 정렬 완료
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■ A-3. U-Bout 와 L-Bout 의 제일 넓은 곳의 중간점을 세로중앙선으로 선택할 경우

이 경우에는 뒷판의 에지 끝단이 아닌 퍼플링의 외측 라인을 기준으로 합니다(고악기의 경우 에지가 마모되어 정확한
폭을 알 수 없기 때문).

수직 참고선 [Guide-w1,2,3] 을 활용하여 U-Bout과 L-Bout의 가장 넓은 지점(퍼플링 외측 라인)에 참고선을 표시하고,
위아래 양쪽의 총 4곳에서 퍼플링 외측 라인과 참고선이 모두 일치하도록 이미지를 움직이거나 회전시켜서 조정합니다.

1. 먼저, 이미지를 상하로 이동시켜서 원점의 높이를 맞추고나서, 이미지를 좌우로 이동시켜 대략적으로 중앙을
맞춥니다.

2. 수직 참고선을 켜고 U/L-Bout 의 가장 넓은 곳(퍼플링 외측 라인)의 넓이 값을 대략적으로 입력합니다. 수직
참고선 1개당 2개의 수직선이 생성됩니다.(80입력시, +80과 -80에 하나씩 생성)

3. 화면에 표시된 수직 참고선과 이미지를 보면서 수직 참고선의 위치값을 적절히 조절하고, 동시에 이미지를 좌우
이동하여 양측의 참고선과 퍼플링 외측 라인이 일치하도록 조정합니다.
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4. 하단의 양측이 맞았으면 그 다음은 상단을 맞춥니다. 상단을 맞추기 위해서는 이미지를 회전시켜야 하며, 이때는
하단도 조금 움직이게 되므로 다시 조정해야 합니다. 이렇게 상하단을 번갈아가면서 조정해서 4군데가 모두
참고선에 일치하도록 조정하고 최종적으로 원점도 다시 확인합니다.

Figure 32: U-Bout 의 정렬과 완성
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B. 크기 조정

세로중앙선 정렬을 마쳤다면 이번에는 크기를 조정합니다. 크기 조정은 다음의 두 방법 중에서 선택할 수 있습니다.

• B-1: 악기 몸체 길이(에지 포함)를 기준으로 하는 경우
• B-2: 몰드 길이를 기준으로 하는 경우

기존의 악기를 토대로 디자인할 때 악기의 크기를 결정하는데는 두가지의 선택지가 있을 것입니다. 하나는 기존
악기의 실제 제원을 그대로 따르는 경우이며, 또하나는 조금 수정을 가하는 경우입니다. 예를 들어, 기존 악기의 몸체
길이가 356mm 라고 할 때, 동일하게 356mm 로 할 것인가, 또는 현재 대부분 355mm 로 제작하므로 355mm 로 약간
축소해서 만들 것인가라는 문제입니다.

전자의 경우에는 참고 이미지의 크기를 몸체 길이 356mm에 맞춘 상태에서 몰드 길이와 에지폭이 얼마인지 측정하여
그대로 적용해야 할 것입니다. 반면 후자의 경우에는, 세가지 모두 사용자가 미리 결정한 후에, 참고 이미지의 몰드
길이(=퍼플링 외측 라인)를 자신이 결정한 값에 맞춰야 합니다. 따라서 B-1 은, 원본 악기의 실제 제원대로 제작하는
경우이며, B-2 는 자신이 정한 크기에 맞춰서 제작하는 경우에 해당합니다.

※ 아래의 작업을 위해서는, 앞단계에서 세로중앙선 정렬이 모두 완료되어 있어야 합니다.
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■ B-1. 몸체 길이를 기준으로 하는 경우

1. 몸체 길이가 기준이므로, 악기 하단의 에지 끝단이 원점에 있는지 확인하고 만약 원점에서 벗어나 있다면 다시
정확히 원점을 정렬한다.

2. 원호 참고선 (Guide-Arc)을 켜고 (height) 입력란에 목적하는 몸체 길이(예:356)를 입력한다. (원호 참고선이
표시되며, 원호의 반지름은 기본값으로 설정된다.)

3. [Zoom Image]의 버튼들을 이용하여 악기 상단의 퍼플링 외측 라인이 원호 참고선의 중간점과 일치하도록
이미지를 확대합니다.
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4. 원호 참고선의 중앙 구간(넥의 폭 정도)이 퍼플링 외측 라인과 잘 일치하도록 원호 참고선의 반지름(radius)을
조절한다. (퍼플링 라인은 점진적으로 곡률이 바뀌는 곡선이므로 원호 참고선과 완전히 일치하지는 않으며 넥의
폭 정도의 구간만 일치하면 된다.)

5. 버튼 주위의 에지 라인이 원호 참고선과 잘 일치하도록 [Zoom Image] 버튼들을 이용하여 이미지를 축소한다.
(참고 이미지의 악기는 정확히 356mm 가 된다.)

6. 메인 윈도우에서 작성하는 몰드 외형선(Mould Outline)의 최하단은 원점에 위치하므로(점 Z), 악기의 몰드
외형선 최하단도 원점에 와야 한다. 따라서, [Move Image] 의 상하 화살표 버튼만을 이용해서 악기 하단의
퍼플링 외측 라인이 y=0 에 오도록 이미지를 이동시킨다.

※ 원호 참고선을 사용하는 이유는, 뒷판은 버튼 때문에 상단의 끝을 알 수 없기 때문입니다. 확대한 퍼플링 외측
라인의 모양과 동일한 모양의 원호 참고선에 뒷판의 에지 라인을 맞춰서 상단 끝지점을 찾는 것입니다.

이상으로 참고 이미지 설정은 끝이며, 별도의 동작없이 [참고 이미지 설정/결과 윈도우] 를 닫고 메인 윈도우에서
작업합니다. 재설정하고 싶을 때는 [Reset Image] 또는 [Clear All] 을 클릭합니다.

H.I.S. Violin Atelier, Manual, March 2026 Page 47 of 53



Violin Designer, v.3.0.0 User Manual

■B-2. 몰드 길이를 기준으로 하는 경우

1. 악기 하단의 퍼플링 외측 라인이 y=0 선에 오도록 [Move Image]의 상하 화살표 버튼만을 이용해서 이미지를
이동한다. (이미 세로중앙선 정렬을 마친 상태이므로 절대로 좌우 이동, 또는 회전시켜서는 안됩니다.)

2. 수평 참고선 (Guide-h1)을 켜고 폼 길이(예:347)를 입력 (참고선이 표시된다)

3. [참고 이미지 설정 윈도우]의 [Zoom Image]의 버튼들을 이용하여 악기 상단의 퍼플링 외측 라인이 참고선과
일치하도록 이미지를 확대하거나 축소

4. 참고 이미지 설정 완료. 별도의 동작없이 [참고 이미지 설정/결과 윈도우] 를 닫고 메인 윈도우에서 작업 계속.
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7.8.3 참고 이미지를 이용한 디자인 작업

참고 이미지의 설정이 모두 끝났다면 [메인 윈도우]에서 실제 디자인 작업을 실시합니다.

참고 이미지 설정 작업은 [메인 윈도우]에서의 디자인 작업과 관계없이 언제든 다시 실시할 수 있으며 그 결과는
자동으로 [메인 윈도우]의 작업에 반영됩니다. 또한, [참고 이미지 설정/결과 윈도우]의 여러가지 참고선은 [메인
윈도우]의 작업에서 유용한 도구로 사용할 수 있습니다(넓이 측정 등).

전제적인 작업은, [참고 이미지 설정 > 프리셋 적용 > 제어점 위치 수정 > 곡선 설정] 순서로 실시합니다.

아래는 참고 이미지의 악기를 그대로 카피하는 경우의 작업 조건과 상세 작업 방법입니다.

■ 작업 조건

• 세로중앙선: A-1, 좌우 접합 라인
• 악기의 크기: B-1, 악기의 몸체 길이 기준, 355mm, (몰드 길이와 에지폭은 이미지에서 측정하여 적용)
• 원점 정렬: 악기 하단의 퍼플링 외측 라인이 y=0 에 위치
• 프리셋: 바이올린

■ 상세 작업 방법

1. 참고 이미지 설정 작업 완료
(참고 이미지 설정은 [메인 윈도우]와는 별도로 동작하므로 메인 작업 중 아무때나 실시할 수 있습니다.)

2. [메인 윈도우]에서, [MODEL NAME] 입력
3. [PRESET] 항목에서 [Violin] 선택
4. [B.Width of Corner & Junction] 항목에서 [UseMy Value] 선택 (코너 폭을 직접 입력해야하므로 Auto를 선택하면

입력할 수가 없다.)
5. [LAYER] 항목에서 [Ref.Image] 선택
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6. [Calculate & Draw] 버튼을 클릭하면, [결과 윈도우]에 참고 이미지와 프리셋 곡선이 함께 표시된다.
이 상태에서, 참고 이미지를 보면서 디자인을 수정한다.

Figure 33: [결과 윈도우] 참고 이미지와 바이올린의 프리셋 디자인

7. 악기 몸체 길이는 355mm 이지만 몰드 길이를 모르므로 [참고 이미지 설정 윈도우]에서 이미지의 몰드 길이를
측정한다. [Guide-h2] 를 켜고 [Guide-h2] 라인이 악기 상단부 퍼플링 외측 라인에 오도록 조정하여 값을 알아
낸다.
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8. 위에서 얻은 몰드 길이(348.2)를 [메인 윈도우]의 [2.(AZ)Length of Mould]에 입력한다.

9. 악기 몸체 길이와 몰드 길이를 토대로 에지폭을 계산하여 [메인 윈도우]의 [1.( EA)Width of Edge]에 입력한다.
(에지폭 = (몸체 길이 - 몰드 길이)/2 = (355-348.2)/2 = 3.4)

10. [참고 이미지 설정 윈도우]의 수평/수직 참고선들을 활용하여 나머지 제어점(U1,X1,M1,Y1,L1)들의 위치를
측정하고, [메인 윈도우]의 [GEOMETRY] 항목의 해당하는 입력란에 값을 입력한다. 단, [참고 이미지 설정
윈도우]의 수직 참고선의 값(넓이)은 악기 좌측만의 넓이이므로 [메인 윈도우]에 입력할 때는 그 두배의 값을
입력해야 하며, 입력란의 좌측에 자동 계산 결과가 표시되므로 해당 값을 입력한다. 코너 연결점(P1,Q1)의
위치는 X1,Y1 의 위치가 확정된 후에 적절히 조절하여 입력한다.

Figure 34: 제어점 U1 관련 값 입력 (U-Bout 폭과 높이), 우하단: 마우스 커서의 현재 위치값

[참고 이미지 설정 윈도우]의 수평/수직 참고선들을 이용하지 않고, [메인 윈도우]의 [GEOMETRY] 항목의 값을
바로 수정해도 된다. (이미지를 보면서 [GEOMETRY] 항목의 값을 수정하고 [Calculate & Draw] 버튼을 눌러
수정된 디자인을 즉시 확인하는 과정을 반복)
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11. 모든 제어점의 위치가 결정되면 [결과 윈도우]에서 사진과 곡선을 비교하면서 [메인 윈도우]의 [CURVES] 항목
에서 곡선 모양을 수정하여 완성한다. 완성 후에는 디자인 파일을 저장하고(Save to Files) 설정값을 저장한다
(Export).

Figure 35: 완성된 디자인
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8 개발 환경과 사용 환경

본 소프트웨어는 《Python 3.10 + Tkinter》 환경에서 개발되었으며 《Windows 11》에서만 동작 확인되었습니다.

9 후원

본 소프트웨어는 모든 현악기 제작가를 위해 개발되었으며,
누구나 모든 기능을 제한 없이 무료로 사용하실 수 있습니다.
여러분의 소중한 후원은 현악기 제작 기술 발전에 큰 밑거름이 됩니다.

후원 안내:
(Korea Only) 카카오뱅크 / 3333-26-9281963 / 히스바이올린(HISVIOLIN)
(International) PayPal: https://paypal.me/37510519

참고 사이트

H.I.S. Violin Atelier – https://www.hisviolins.com

Copyright © 2026 Hwang, Il-Seok. All rights reserved.

Unauthorized modification and commercial sale are prohibited.
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